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Introduction

Use the SYSPRO Connector to send and retrieve data between BPA Platform and your SYSPRO installation. This 

allows for data to be synchronised between SYSPRO and third-party systems that it does not normally connect with, 

such as ERP systems.

All communication uses XML; BPA Platform recordsets cannot be used as data inputs unless converted to XML first 

(using the Convert Recordset to XML or Transform Data tools, for example). You use the Connector to map BPA 

Platform data to SYSPRO modules and functions — see Supported Objects.

XML responses received back from the SYSPRO API can be saved and used by other BPA Platform tools for further 

processing.

The SYSPRO Connector Tool Pack

The tool pack consists of:

 SYSPRO Connector Agent — The Agent communicates directly with the SYSPRO API. It can be installed on 

any computer that has access to both the BPA Platform server and the SYSPRO company database, or even 

local to the BPA Platform server.

 SYSPRO Connector — The Connector communicates with the SYSPRO Connector Agent instead of 

interacting directly with the SYSPRO company database. It must be installed on the BPA Platform server and 

any remote BPA Platform client machines which run SYSPRO Connector tasks.

System Requirements

The following prerequisite software must be in place before installing the SYSPRO Connector.

Minimum BPA Platform Version

The SYSPRO Connector requires BPA Platform 2020 Update 1 or above.

Minimum SYSPRO Version

The SYSPRO Connector supports the following versions:

 SYSPRO version 7

 SYSPRO version 7.1

 SYSPRO version 8
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Architecture

The following diagram provides an example architectural layout of the Connector and Agent with SYSPRO. You can 

choose to locate the SYSPRO Connector Agent on any machine accessible by the BPA Platform server or on the 

server itself.

Working with Other Tools

The SYSPRO Connector can directly interact with the following tools:

Consuming from Other Tools

The SYSPRO Connector can consume output from the following tools:

Icon Tool Name Tool Category

Import XML Document Input
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Icon Tool Name Tool Category

Retrieve Text Message Input

Convert Recordset to XML Format

Transform Data Format

Call Task Execute

 Applications Platform Connector Data Connectors

SYSPRO Connector Data Connectors

In addition, the SYSPRO Connector can consume the output from other Data Connector tools that provide 

connectivity to an external application, such as an ERP or CRM system.

Objects Consumed

The SYSPRO Connector consumes the following objects exposed by other steps:

 XML — XML data from any BPA Platform tool capable of exposing such data (see above)

Exposing to Other Tools

The following tools can directly consume output form the SYSPRO Connector:

Icon Tool Name Tool Category

Retrieve Text Message Input

Convert XML to Recordset Format

Run Microsoft Reporting Services Format

Transform Data Format
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Icon Tool Name Tool Category

Save File Output

Call Task Execute

Applications Platform Connector Data Connectors

Web Service Connector Data Connectors

SYSPRO Connector Data Connectors

In addition, other Data Connector tools that provide connectivity to an external application, such as an ERP or CRM 

system, can also consume the output from the SYSPRO Connector.

Objects Exposed

The SYSPRO Connector tool outputs the following objects which can be consumed by other tools:
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 InputData

This document contains the input XML received by the SYSPRO Connector tool. It is only available if a task 

step has been selected as the Data Source (see About the General Tab).

 OutputData

The OutputData object contains two sub-objects:

 XmlString — This is the XML document produced by the tool, containing data returned from SYSPRO 

for all operations. Also included are the key fields for the mapped elements affected by the used 

operation and a SupplementaryReference field for task auditing purposes.

The mapped fields in the Mapping tab (see About the Mapping Tab) define the structure of this XML 

document.

 XmlSchema — This contains the output schema in XSD format.

 ErrorData

The ErrorData object also contains two sub-objects:

 XmlString — This contains any error data reported by SYSPRO

<Error> — All errors are created as an <Error> node, with the following sub-nodes:

   <Object /> — The name of the requested object

   <CODE /> — The error code returned by SYSPRO

   <MESSAGE /> — The corresponding error message

   <EXTENDEDINFO /> — A string containing additional information about the error

   <INPUTDATA /> — The header input data (excluding child nodes) mapped for the object, plus all 

data contained in SupplementaryReference

</Error>

For more information about the errors received, see Error Handling.

 XmlSchema — This contains the output schema in XSD format.

 Step Properties

Standard step properties are also available allowing you to use statistical data of the SYSPRO Connector step.

Where Can the XML Output be Used?

The incoming XML is translated into the XML format for the object and operation selected in the configuration. The 

data for the linked fields is brought across into the output XML — only those fields that are linked are brought 

across. The XML is passed to the Connector, which then:

 Processes the data
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 Performs the operation requested

 Receives an XML document containing the response

Both the OutputData and ErrorData documents can be directly used by succeeding task steps that can consume 

XML data, as part of an application integration or synchronisation process. To use the documents in a non-XML 

consuming tool, use a Convert XML to Recordset step first to create a recordset copy of the XML data.

The XML documents are also available as consumable objects from the Task Browser (XmlString). When used in a 

task step, such as Format as Text or Save File, this exposes the actual XML string.

Error Handling

Errors are written to the BPA Platform Event Log (Tasks toolbar > Event Log ). You define how errors are 

handled in the Options tab of the tool (see About the Options Tab).

Reasons for the errors could include:

 Web service connection errors

 User privilege errors

 Errors, messages, and warnings from the SYSPRO API

 Any reported task runtime errors, including Agent errors, such as, loss of connection
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Global Configuration

The global configuration for the SYSPRO Connector is used to create connections to the SYSPRO Connector Agent 

and from the Agent to SYSPRO itself.

You open this interface from the resources tree — expand System > Tools > Data Connectors and double-click 

SYSPRO Connector in the items list.

When a connection is created, the available objects and fields of your SYSPRO installation are retrieved.

Click Add to create a connection to SYSPRO.

NOTE: You may be restricted as to the number of SYSPRO company database connections you can create. For 

more information, refer to the BPA Platform product help or consult your Codeless Platforms account manager 

or partner.

Using Extended Logging

Selecting this option exposes the full XML parsed between the SYSPRO Connector and SYSPRO. 

Without extended logging, the Event Log only contains start and end of transaction messages, plus any error 

messages encountered at runtime.

You can view the extended log in the BPA Platform Event Log (Tasks toolbar > Event Log ).
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TIP: The Event Log database table may grow substantially large as extended logging adds additional rows for 

each call made to and from the Connector. To manage this, adjust the maintenance routine for the Event Log — 

refer to the BPA Platform product help.

About the Agent Connection Tab

You configure the connection to the SYSPRO Connector Agent here.

Configure a meaningful Connection Name for this Agent connection; this is the Connection name used when 

creating SYSPRO Connector task steps.

Specify the Integration Agent Server  name of the computer hosting the SYSPRO Connector Agent. You can use 

either the hostname or IP address.
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By default, the connection to the server is over HTTP, on TCP port 4211. Use the Advanced button to either Set a 

Custom Port Number if 4211 is already in use by the server, or to Use HTTPS to communicate to the server.

If you are upgrading from a beta release of the SYSPRO Connector, select Use Legacy Schemas after completing 

the upgrade to ensure existing tasks continue to run successfully.

Update Objects and Operations

Enabling Update Objects and Operations allows the SYSPRO schema in BPA Platform to be refreshed every time 

an update is made in SYSPRO itself.

Should you also upgrade SYSPRO to a newer, compatible version, all related schemas within BPA Platform must be 

refreshed. To do this, select this option and save the changes. You must repeat this for each existing connection you 

have defined. 

NOTE: After enabling Update Objects and Operations, you must refresh the schema in each SYSPRO 

Connector task step. You do this in the Mapping tab (Schema Refresh) — see About the Mapping Tab.
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About the SYSPRO Connection Tab

Use the SYSPRO Connection tab to configure how the SYSPRO Connector Agent connects to the SYSPRO company 

database.

Enter the hostname or IP address of the computer hosting the SYSPROWCFService service into Server.

Enter the credentials required to access SYSPRO (Username and Password). Enter the Company database name 

and the Password required by the Agent to access the database.

Use Test Connection to ensure the Agent can communicate with SYSPRO successfully.
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About the Business Object Parameters Tab

Use the Business Objects Parameters tab to set global values for the parameters sent to SYSPRO during 

transactions.

As part of the XML sent from the Connector to SYSPRO, you can also include parameter values that determine how 

the XML is treated. Each parameter has a default value set by SYSPRO but you can override this value on a 

connection or task run basis. The application of the values is prioritised as:

3.  Default value used

2.  Global connection value, if configured, is used over the default value — Note that where a Parameter Value has 

been left blank in the global configuration, this does not indicate a NULL value as a new value for that parameter

1.  New value passed at task run time as mapped in the Mapping tab — for more information, see About the Mapping 

Tab

If any changes occur to your SYSPRO schema which affect the parameters, use Refresh to pull the latest list.
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The formats required by each parameter is outside the scope of this document. For a detailed description of the 

formats, refer to the SYSPRO Connector Data Dictionary.

Step Configuration

When creating new tasks, the SYSPRO Connector is located under Data Connectors of the Task Browser.

NOTE: It is not possible to add the Connector to the task until at least one connection to a SYSPRO database has 

been defined in the global configuration.

To add a new SYSPRO Connector step to an existing task, do the following:

From the relevant task, either:

 Click and drag the SYSPRO Connector icon from the Task Browser to the task Design area.

 From the task's Design tab, right-click on empty space and select New > Data Connectors > SYSPRO 

Connector.

For a detailed description of how to create new tasks, refer to the product help.
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About the General Tab

Use the General tab to choose the BPA Platform data source to be mapped to the SYSPRO objects. The data source 

must be in XML form. To map BPA Platform recordsets, configure a Convert Recordset to XML or Transform Data 

step in the task before the SYSPRO Connector step, then select this as Task step (see below).

Provide a meaningful Name and Description for this step.                 

TIP: If this task instance makes use of two or more SYSPRO Connector steps, ensure the Name used is unique 

for each individual step.

Data source can either be:

 No data source — If you don’t make use of a dedicated XML input source, select this option to use BPA 

Platform variables in place of the XML or recordset objects’ fields.

For example, you can extract various bits of information from an email and store them in BPA Platform 

variables. The variables are mapped to SYSPRO operational objects and fields to store in the database for 

later use.

 Task step — The data source can be set to an available BPA Platform XML data source.

Only those steps that are capable of natively exposing an XML document at runtime are listed. This may be 

another SYSPRO Connector step, or a tool such as Convert Recordset to XML or Transform Data.
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 Custom schema — An XML schema defines the structure of the parsed XML: what tags are present, and the 

nesting of the tags. You Define the schema of the XML that is used as the input data source for this step. The 

SYSPRO Connector tool uses the industry standard XSD format. Any XML processed by this step must 

conform to this schema else an error will be reported.

If the XSD schema is available, either import it into the Custom Schema Configuration (use the Import 

XSD/XML File button), or copy and paste it into the configuration box.

If the XSD schema is not available, you can import an example of the runtime XML (Import XSD/XML File), or 

copy and paste it into the configuration box. Use the Parse button to create the schema.

 Input source variable — As well as defining the schema, specify the BPA Platform variable that 

contains the XML data at runtime.
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About the Connection Tab

You must specify the SYSPRO Connection this step must use.

All connections created in global configuration are presented here.

Alternatively, you can use a BPA Platform variable or formula to create a dynamic connection, where the connection 

used is determined by runtime circumstances. At runtime, the contents of the variable must match the name of one 

of the global connections — this is case-sensitive. To do this, you must install a SYSPRO Connector Agent for each 

individual company database you want to monitor (even though access is through the same API). All Agents must be 

registered with the BPA Platform server and a separate global connection created for each Agent.
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About the Mapping Tab

Use the Mapping tab to define links between the data source XML (see About the General Tab) and those required by 

SYSPRO. This defines how, at runtime, the incoming XML is to be translated into the XML required for the relevant 

object and operation.

The Object drop-down shows the available SYSPRO modules.  The Operations drop-down shows the business 

objects and functions available for the selected Object

Further down, the left-hand XML tree structure shows those data source fields available for mapping . The right-

hand XML tree structure displays those input fields for the selected Object and Operation.

TIP: If you have selected No data source in the General tab, you must add BPA Platform formulas and variables 

to the left-hand data source XML tree structure before mapping.

Creating Mappings

Create links by dragging and dropping a data source field (left) onto its corresponding SYSPRO Connector input field 

(right). Only linked fields are used in the output XML.

BPA Platform formulas and variables can be included in the source data even when using a Task step or Custom 

schema  — drag them from the Task Browser to the data source’s XML; these can then be linked to the relevant 

input fields. BPA Platform recordsets must first be converted to XML using either the Convert Recordset to XML or 

Transform Data tool before they can be used here.
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Each operation has an additional field, SupplementaryReference, which allows for traceability when transferring 

data from one place to another. When mapped, the data resides locally at runtime. It is added to the output, and 

creates a record for reference purposes only — you can choose to map any field to SupplementaryReference to 

assist with checking where the data originated from or at what time the data transfer occurred, for example.

The SYSPRO Connector tool uses eXtensible Stylesheet Language Transformations (XSLT) to translate the received 

XML. The Advanced Translations (XSLT) tab shows the XSLT generated for the links created for the object and 

operation. Use Enable Free Type Mode to directly edit the XSLT — this is particularly useful when translating a non-

standard requirement.

Refreshing the SYSPRO Schema

If new fields, objects, and operations have been added to your SYSPRO instance after this task step was originally 

created, use Schema Refresh to make the latest API metadata available for use (ensure Update Objects and 

Operations is selected first in the relevant global connection).

Supported Objects

The following SYSPRO modules, business objects, and methods are supported. Note that "modules" are displayed in 

the Objects drop-down, with "business objects" and "methods" combined into a single display (Operation).

NOTE: This information references SYSPRO version 8. If using a different version, refer to your SYSPRO 

documentation.

Module (Object): Accounts Payable

The following SYSPRO business objects and methods are available as operations for the Accounts Payable object.

Business Object Business Object (Long Hand) Method

APSQ51 AP EC Tax Distribution QUERY

APSQ52 AP Tax Distribution Report QUERY

APSQQS AP Second Tier Tax Report QUERY

APSQRY AP Supplier Query QUERY

APSTIN AP Invoice Posting POST

APSTPY AP Payment Cycle Maintenance POST
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Module (Object): Accounts Receivable

The following SYSPRO business objects and methods are available as operations for the Accounts Receivable 

object.

Business Object Business Object (Long Hand) Method

ARSQ70 AR Payments Distribution Query QUERY

ARSQ85 AR Customer Movement Report QUERY

ARSQMA List of Multiple Ship to Addresses QUERY

ARSQPR AR Payment Run Report QUERY

ARSQRY AR Customer Query QUERY

ARSTIN AR Invoice Posting POST

ARSTPY AR Payments and Adjustments POST

Module (Object): Cash Book

The following SYSPRO business objects and methods are available as operations for the Cash Book object.

Business Object Business Object (Long Hand) Method

CSHQ70 Cash Book Tax Report QUERY

CSHTWD Cash Book Deposits and Withdrawls POST

Module (Object): Contact Management System

The following SYSPRO business objects and methods are available as operations for the Contact Management 

System object.

Business Object Business Object (Long Hand) Method

CMSQRY Contact Query QUERY
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Module (Object): General Ledger

The following SYSPRO business objects and methods are available as operations for the General Ledger object.

Business Object Business Object (Long Hand) Method

GENQBG GL Balance GRN's Query QUERY

GENQRY GL General Ledger Query QUERY

GENTJL GL Journal Posting POST

Module (Object): Inventory

The following SYSPRO business objects and methods are available as operations for the Inventory object.

Business Object Business Object (Long Hand) Method

CFGTPC Product Configurator POST

INVQPH Inventory Price History Query QUERY

INVQPL Inventory Price List Query QUERY

INVQRY Inventory Query QUERY

Module (Object): Purchase Orders

The following SYSPRO business objects and methods are available as operations for the Purchase Orders object.

Business Object Business Object (Long Hand) Method

PORQ84 GRN Journal Report Business Object QUERY

PORQRY PO Purchase Order Query QUERY

PORTGN GRN Post GRN Adjustments POST

PORTGR GRN Post GRN details POST

PORTOI PO Purchase Order Import POST

PORTOR PO Purchase Order Receipts POST

PORTRA PO Requisition Approve Clear POST

PORTRQ PO Requisition Entry POST
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Module (Object): Return Merchandise Authorization

The following SYSPRO business objects and methods are available as operations for the Return Merchandise 

Authorization object.

Business Object Business Object (Long Hand) Method

RMATRH Create / Update RMA Header POST

RMATRL Create / Update RMA Detail POST

Module (Object): Sales Orders

The following SYSPRO business objects and methods are available as operations for the Sales Orders object.

Business Object Business Object (Long Hand) Method

SORQDD SO Dispatch Note Documents Query QUERY

SORQDN SO Dispatch Note Query QUERY

SORQID SO Sales Order Invoice Document Query QUERY

SORQND SO Dispatch Invoice Document Query QUERY

SORQRY SO Sales Order Query QUERY

SORQSO SO List of Sales Orders QUERY

SORTDA Dispatch Note Add Lines from Sales Order POST

SORTDN Dispatch Note Creation From Sales Order POST

SORTOI SO Sales Order Import POST

SORTOS SO Change Order Status POST

SORTOX SO Order or Order Line Cancel POST

20 of 23



Module (Object): System Manager

The following SYSPRO business objects and methods are available as operations for the System Manager object.

Business Object Business Object (Long Hand) Method

APSSSP AR Supplier Maintenance ADD

APSSSP AR Supplier Maintenance DELETE

APSSSP AR Supplier Maintenance UPDATE

ARSSCS AR Customer Maintenance ADD

ARSSCS AR Customer Maintenance DELETE

ARSSCS AR Customer Maintenance UPDATE

BOMSRO BOM Routing Maintenance ADD

BOMSRO BOM Routing Maintenance DELETE

BOMSRO BOM Routing Maintenance UPDATE

BOMSST BOM Structure Maintenance ADD

BOMSST BOM Structure Maintenance DELETE

BOMSST BOM Structure Maintenance UPDATE

CMSSCO Contact Maintenance UPDATE

CMSSCO Contact Maintenance DELETE

CMSSCO Contact Maintenance ADD

COMFCH COM Generic Fetch FETCH

COMFND COM Generic Find QUERY

COMSFM COM Custom Form Setup UPDATE

COMSFM COM Custom Form Setup ADD

COMSFM COM Custom Form Setup DELETE

COMSMM Multimedia Setup Business Object UPDATE

COMSMM Multimedia Setup Business Object DELETE

COMSMM Multimedia Setup Business Object ADD

COMTFM COM Custom Form Post POST

IMPQTS Tax Submission Query QUERY
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Business Object Business Object (Long Hand) Method

IMPSCU Currency Exchange Rate Maintenance UPDATE

IMPSCU Currency Exchange Rate Maintenance DELETE

IMPSCU Currency Exchange Rate Maintenance ADD

INTQ08 Interface List of States QUERY

INVSPR Inventory Price Maintenance ADD

INVSPR Inventory Price Maintenance UPDATE

INVSPR Inventory Price Maintenance DELETE

INVSST Inventory Stock Code Maintenance ADD

INVSST Inventory Stock Code Maintenance DELETE

INVSST Inventory Stock Code Maintenance UPDATE

INVSWS Inventory Stock/Warehouse Maintenance ADD

INVSWS Inventory Stock/Warehouse Maintenance DELETE

INVSWS Inventory Stock/Warehouse Maintenance UPDATE

Module (Object): Work in Progress

The following SYSPRO business objects and methods are available as operations for the Work in Progress object.

Business Object Business Object (Long Hand) Method

WIPQRY WIP Query QUERY

WIPTJB WIP Job Creation and Maintenance POST

WIPTJC WIP Job Closure POST

WIPTMI WIP Job Specific Issues POST
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About the Options Tab

The Options tab allows you to define how errors in this step are handled at task runtime.

If an error occurs, you can decide whether the step should Continue processing, or terminate the step 

immediately (Abort Step).

If the step is aborted, you can choose to Continue processing onto the next step in the task, or terminate the 

whole task immediately (Abort Task). By allowing the task to Continue, you can use the error XML received back in 

a Save File step for investigation purposes, for example. 
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